PASS Sample Size Software

NCSS.com

Chapter 199

Tests for Two
Proportions using
Effect Size
Introduction
This procedure provides sample size and power calculations for one- or two-sided hypothesis tests of the
difference between two independent proportions using the effect size. The details of procedure are given in Cohen
(1988). The design corresponding to this test procedure is sometimes referred to as a parallel-groups design. In
this design, two proportions from independent populations are compared by considering their difference. The
difference is formed between transformed values of the proportions, formed to create variables that are more
normally distributed than the raw proportions and that have a variance not related to the values of the proportions.

Test Procedure
If we assume that P1 and P2 represent the two proportions. The effect size is represented by the difference h
formed as follows
ℎ = 𝜑𝜑1 − 𝜑𝜑2

where

𝜑𝜑𝑖𝑖 = 2 arcsine��𝑃𝑃𝑖𝑖 �

This is referred to as the arcsine, the arcsine root, or the angular transformation.
The null hypothesis is H0: h = 0 and the alternative hypothesis depends on the number of “sides” of the test:
Two-Sided:
Upper One-Sided:
Lower One-Sided:

H1 : ℎ ≠ 0 or H1 : 𝜑𝜑1 − 𝜑𝜑2 ≠ 0

H1 : ℎ > 0 or H1 : 𝜑𝜑1 − 𝜑𝜑2 > 0

H1 : ℎ < 0 or H1 : 𝜑𝜑1 − 𝜑𝜑2 < 0

A suitable Type I error probability (α) is chosen for the test, the data is collected, and a z-statistic is generated
using the formula
𝑧𝑧 =

𝜑𝜑�1 − 𝜑𝜑�2

�

𝑁𝑁1 +𝑁𝑁2
2𝑁𝑁1 𝑁𝑁2
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This z-statistic follows a standard normal distribution. The null hypothesis is rejected in favor of the alternative if,
for H1 : ℎ ≠ 0, 𝑧𝑧 < 𝑧𝑧𝛼𝛼/2 or 𝑧𝑧 > 𝑧𝑧1−𝛼𝛼/2

for H1 : ℎ > 0, 𝑧𝑧 > 𝑧𝑧1−𝛼𝛼

for H1 : ℎ < 0, 𝑧𝑧 < 𝑧𝑧𝛼𝛼

Comparing the z-statistic to the cut-off z-value is equivalent to comparing the p-value to α.

Power Calculation
The power of a one-sided test is calculated using the formulation of Cohen (1988):
𝑁𝑁′
𝑧𝑧1−𝛽𝛽 = ℎ� − 𝑧𝑧1−𝛼𝛼
2

where

𝑁𝑁′ =

2𝑁𝑁1 𝑁𝑁2
𝑁𝑁1 +𝑁𝑁2

The Effect Size
As stated above, the effect size h is given by ℎ = 𝜑𝜑1 − 𝜑𝜑2 . Cohen (1988) proposed the following interpretation
of the h values. An h near 0.2 is a small effect, an h near 0.5 is a medium effect, and an h near 0.8 is a large effect.
These values for small, medium, and large effects are popular in the social sciences.
Cohen (1988) remarks that the value of h does not match directly with the value of P1 – P2, so care must be taken
when using it. For example, all of the following pairs of values of P1 and P2 result in an h of about 0.30, even
though the actual differences P1 – P2 are quite different.
P1
0.21
0.39
0.55
0.65
0.78
0.87
0.97

P2
0.10
0.25
0.40
0.50
0.60
0.75
0.90

P1 – P2
0.11
0.14
0.15
0.15
0.18
0.13
0.07

h
0.3
0.3
0.3
0.3
0.3
0.3
0.3
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power, Sample Size, Effect Size, and Alpha. In most situations, you will likely select either Power or
Sample Size.
The ‘Solve For’ parameter is the parameter that will be displayed on the vertical axis of any plots that are shown.

Test Direction
Alternative Hypothesis
Specify whether the alternative hypothesis of the test is one-sided or two-sided. If a one-sided test is chosen, the
hypothesis test direction is chosen based on whether the effect size is greater than or less than zero.
Two-Sided Hypothesis Test
H0: h = 0 vs. H1: h ≠ 0
One-Sided Hypothesis Tests
Upper: H0: h ≤ 0 vs. H1: h > 0
Lower: H0: h ≥ 0 vs. H1: h < 0

Power and Alpha
Power
Power is the probability of rejecting the null hypothesis when it is false. Power is equal to 1 - Beta, so specifying
power implicitly specifies beta. Beta is the probability obtaining a false negative with the statistical test. That is, it
is the probability of accepting a false null hypothesis.
The valid range is 0 to 1. Different disciplines have different standards for setting power. The most common
choice is 0.90, but 0.80 is also popular.
You can enter a single value, such as 0.90, or a series of values, such as .70 .80 .90, or .70 to .90 by .1.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
Alpha
Alpha is the probability of obtaining a false positive with the statistical test. That is, it is the probability of
rejecting a true null hypothesis. The null hypothesis is usually that the parameters of interest (means, proportions,
etc.) are equal.
Since Alpha is a probability, it is bounded by 0 and 1. Commonly, it is between 0.001 and 0.10. Alpha is often set
to 0.05 for two-sided tests and to 0.025 for one-sided tests. You can enter a single value, such as 0.05, or a series
of values, such as .05 .10 .15, or .05 to .15 by .01. When a series of values is entered, PASS will generate a
separate calculation result for each value of the series.
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Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N1, solve for N2
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1, solve for N2”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
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For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
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N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.
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Effect Size
h
Enter one or more values for h, the effect size, that you wish to detect. This is a standardized difference between
the group proportions. The effect size is calculated using
h = φ₁ - φ₂,
where φᵢ = 2 arcsine(√Pᵢ) and P1 and P2 are the group proportions assumed by the alternative hypothesis. Note
that 0 ≤ φᵢ ≤ 3.14159. Thus, the physical interpretation of these values may be difficult to grasp.
The value of h must be between -6.28318 and 6.28318.
You can enter a single value such as 0.5 or a series of values such as 0.2 0.5 0.8 or 0.2 to 0.8 by 0.1. When a
series of values is entered, PASS will generate a separate calculation result for each value of the series.
Cohen's Effect Size Table
Cohen (1988) gave the following interpretation of h values that is still popular.
•

Small
h = 0.2

•

Medium
h = 0.5

•

Large
h = 0.8

Interpretation
A value of h can have several interpretations. So care must be taken when using it. For example, all of the
following pairs of values of P1 and P2 result in an h of about 0.30, even though the actual differences P1 - P2 are
quite different.
P1=0.21 and P2 = 0.10 Diff = 0.11
P1=0.39 and P2 = 0.25 Diff = 0.14
P1=0.55 and P2 = 0.40 Diff = 0.15
P1=0.65 and P2 = 0.50 Diff = 0.15
P1=0.78 and P2 = 0.60 Diff = 0.18
P1=0.87 and P2 = 0.75 Diff = 0.13
P1=0.97 and P2 = 0.90 Diff = 0.07
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Example 1 – Finding the Sample Size
Researchers wish to compare two types of local anesthesia using a balanced, parallel-group design. Subjects in
pain will be randomized to one of two treatment groups, the treatment will be administered, and the subject’s
evaluation of pain intensity will be measured on a binary scale (acceptable, unacceptable).
The researchers would like to determine the sample sizes required to detect a small, medium, and large effect size
with a two-sided t-test when the power is 80% or 90% and the significance level is 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Proportions using Effect Size procedure. You may then make the appropriate
entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided
Power ...................................................... 0.80 0.90
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
h .............................................................. 0.2 0.5 0.8

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Z Test
Alternative Hypothesis: H1: h ≠ 0
Target
Power
0.80
0.90
0.80
0.90
0.80
0.90

Actual
Power
0.8006
0.9003
0.8013
0.9031
0.8074
0.9014

N1
393
526
63
85
25
33

N2
393
526
63
85
25
33

N
786
1052
126
170
50
66

Effect
Size
h
0.20
0.20
0.50
0.50
0.80
0.80

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

References
Cohen, Jacob. 1988. Statistical Power Analysis for the Behavioral Sciences. Lawrence Erlbaum Associates.
Hillsdale, New Jersey
Report Definitions
Target Power is the desired power. May not be achieved because of integer N1 and N2.
Actual Power is the achieved power. Because N1 and N2 are integers, this value is often (slightly) larger than
the target power.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
Effect Size: h = φ1 - φ2 where φᵢ = 2 ArcSine(√Pᵢ). Cohen recommended Low = 0.2, Medium = 0.5, and High = 0.8.
Alpha is the probability of rejecting a true null hypothesis.
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Summary Statements
Group sample sizes of 393 and 393 achieve 80.06% power to reject the null hypothesis of zero
effect size when the population effect size is 0.20 and the significance level (alpha) is 0.050
using a two-sided z test.

These reports show the values of each of the parameters, one scenario per row.

Plots Section

These plots show the relationship between effect size, power, and sample size.
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Example 2 – Validation using Cohen (1988)
Cohen (1988) gives an example on page 199 of a one-sided test in which alpha = 0.05, h = 0.3, and N1 = N2 = 80.
He finds the power to be 0.60.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Proportions using Effect Size procedure. You may then make the appropriate
entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option
Value
Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ One-Sided
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 80
h .............................................................. 0.30

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Z Test
Alternative Hypothesis: H1: h ≠ 0

Power
0.5997

N1
80

N2
80

N
160

Effect
Size
h
0.30

Alpha
0.050

PASS also calculated the power as 0.60 which validates the procedure.
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